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FCC/CDC statements

Federal Communications Commission Statement

This device complies with FCC Rules Part 15. Operation is subject to the
following two conditions:

• This device may not cause harmful interference, and

• This device must accept any interference received including interference
that may cause undesired operation.

This equipment has been tested and found to comply with the limits for a
Class B digital device, pursuant to Part 15 of the FCC Rules. These limits
are designed to provide reasonable protection against harmful interference
in a residential installation. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with
manufacturer’s instructions, may cause harmful interference to radio
communications. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the
interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.

• Increase the separation between the equipment and receiver.

• Connect the equipment to an outlet on a circuit different from that to
which the receiver is connected.

• Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications Statement

This digital apparatus does not exceed the Class B limits for radio noise
emissions from digital apparatus set out in the Radio Interference
Regulations of the Canadian Department of Communications.

This class B digital apparatus complies with Canadian ICES-003.

The use of shielded cables for connection of the monitor to the
graphics card is required to assure compliance with FCC regulations.
Changes or modifications to this unit not expressly approved by the
party responsible for compliance could void the user’s authority to
operate this equipment.
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Safety information

Macrovision Corporation Product Notice
This product incorporates copyright protection technology that is protected
by method claims of certain U.S. patents and other intellectual property
rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision
Corporation, and is intended for home and other limited viewing uses only
unless otherwise authorized by Macrovision Corporation. Reverse
engineering or disassembly is prohibited.

Electrical safety
• To prevent electrical shock hazard, disconnect the power cable from

the electrical outlet before relocating the system.

• When adding or removing devices to or from the system, ensure that
the power cables for the devices are unplugged before the signal
cables are connected. If possible, disconnect all power cables from
the existing system before you add a device.

• Before connecting or removing signal cables from the motherboard,
ensure that all power cables are unplugged.

• Seek professional assistance before using an adpater or extension
cord. These devices could interrupt the grounding circuit.

• Make sure that your power supply is set to the correct voltage in your
area. If you are not sure about the voltage of the electrical outlet you
are using, contact your local power company.

• If the power supply is broken, do not try to fix it by yourself. Contact a
qualified service technician or your retailer.

Operation safety

• Before installing the motherboard and adding devices on it, carefully
read all the manuals that came with the package.

• Before using the product, make sure all cables are correctly
connected and the power cables are not damaged. If you detect any
damage, contact your dealer immediately.

• To avoid short circuits, keep paper clips, screws, and staples away
from connectors, slots, sockets and circuitry.

• Avoid dust, humidity, and temperature extremes. Do not place the
product in any area where it may become wet.

• Place the product on a stable surface.

• If you encounter technical problems with the product, contact a
qualified service technician or your retailer.
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Conventions used in this guide
To make sure that you perform certain tasks properly, take note of the
following symbols used throughout this manual.

Where to find more information
Refer to the following sources for additional information and for product
and software updates.

1. ASUS Websites
The ASUS websites worldwide provide updated information on ASUS
hardware and software products. The ASUS websites are listed in the
ASUS Contact Information on page vii.

2. Optional Documentation
Your product package may include optional documentation, such as
warranty flyers, that may have been added by your dealer. These
documents are not part of the standard package.

WARNING: Information to prevent injury to yourself when
trying to complete a task.

CAUTION: Information to prevent damage to the components
when trying to complete a task.

IMPORTANT: Information that you MUST follow to complete a
task.

NOTE: Tips and additional information to aid in completing a
task.
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ASUS contact information
ASUSTeK COMPUTER INC. (Asia-Pacific)
Address: 150 Li-Te Road, Peitou, Taipei, Taiwan 112
General Tel: +886-2-2894-3447
General Fax: +886-2-2894-3449
Web Site: www.asus.com.tw

Technical Support
MB/Others (Tel): +886-2-2890-7121 (English)
Notebook (Tel): +886-2-2890-7122 (English)
Desktop/Server (Tel): +886-2-2890-7123 (English)
Support Fax: +886-2-2890-7698

ASUS COMPUTER INTERNATIONAL (America)
Address: 44370 Nobel Drive, Fremont, CA 94538, USA
General Fax: +1-502-933-8713
General Email: tmd1@asus.com
Web Site: usa.asus.com

Technical Support
Support Fax: +1-502-933-8713
General Support: +1-502-995-0883
Notebook Support: +1-510-739-3777 x5110
Support Email: tsd@asus.com

ASUS COMPUTER GmbH (Germany and Austria)
Address: Harkortstr. 25, 40880 Ratingen, BRD, Germany
General Email: sales@asuscom.de (for marketing requests only)
General Fax: +49-2102-9599-31
Web Site: www.asuscom.de

Technical Support
Components: +49-2102-9599-0
Notebook PC: +49-2102-9599-10
Support Fax: +49-2102-9599-11
Support Email: www.asuscom.de/support (for online support)

ASUSTeK COMPUTER (Middle East and North Africa)
Address: P.O. Box 64133, Dubai, U.A.E.
General Tel: +9714-283-1774
General Fax: +9714-283-1775
Web Site: www.ASUSarabia.com
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After installing the display drivers, look for the ASUS icon on the
Windows taskbar. Click the ASUS control panel icon to open the ASUS
Control Panel to display a menu composed of shortcuts to the graphics
card various enhanced functions.

1. ASUS Control Panel

ASUS Control Panel icon

Windows  Taskbar

ASUS Control Panel icon
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1.1 Screen resolution setting shortcut
The ASUS Control Panel includes a list of screen resolution setting
shortcut options for easy screen resolution setting. Click one of the listed
screen resolutions available to change the screen resolution settings.

ASUS Control Panel icon

Screen resolution setting
shortcut

After selecting any of the listed screen resolutions, your computer screen
may flicker while adjusting to the new setting. When adjusted it prompts a
timed confirmation dialog box, click OK to apply new settings or Cancel to
abort.

Screen color setting
shortcut
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2.   ASUS VideoSecurity
The ASUS VideoSecurity is a powerful security utility that detects any
change in a specified surveillance region. Using video capture devices,
video snapshots are captured automatically when there is a deviation in
the user-defined surveillance region. Also, a specific program can be
executed or an optional warning message is be sent via email or phone to
the user.

2.1  Limitations
Differences in hardware sensitivity can affect the consistency of the
VideoSecurity utility in detecting possible errors. Before you execute
VideoSecurity, there are some limitations to understand to appropriately
use this application.

• Due to changing temperatures, the captured image of some Charge-
Coupled Devices (CCDs) cameras are distorted, which results in an
errorous detection.

• If the features (e.g., color, luminance) of the object are similar with the
background, the object may not be detected clearly.

• The USB camera cannot capture the object smoothly and immediately
when an object moves too fast.

• VideoSecurity can only process the following pixel formats: UYVY,
YUY2, and I420.

2.2   System Requirements

Software:

• Microsoft Windows 98SE/ME/2000/XP with DirectX 8.0 or later

• Windows Driver Model (WDM) capture driver for your video capture
devices.

• Internet connection (if you want to use Email notification feature)

Hardware:

• Video capture devices like CCD, V8 or Hi-8, which supports UYVY,
YUY2 or I420 pixel format.

• A sound card or sound controller is necessary if you want to play a
warning .wav file.

• A standard voice modem (if you want to use the Warning Phone Call
feature).
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2.3   Running ASUS VideoSecurity
Click the ASUS icon on the taskbar’s status area. Clicking this icon opens
the ASUS Control Panel, then click the ASUS VideoSecurity to run
VideoSecurity.

Command buttons

Start/Stop
The Start/Stop button starts or stops the VideoSecurity watchdog
detection process.

Setup
The Setup button launches the ASUS VideoSecurity Setup Wizard
program (wsetup.exe). Refer to section “2.4 ASUS VideoSecurity Setup”
for more detailed information.

Video Source
The Video Source button allows you to select from available video source
devices. Click the button to display pop-up menu. To select, move  the
mouse over the list of available items then click on the selected item. The
active video source device is denoted by a check mark before the item.

Detect Region
The Detect Region button allows you to define a view port on the
VideoSecurity video window for detection. Click this button then use the
mouse to draw a rectangular detect region.

Status

Setup

Start /
Stop

Detect
Region Show

History

Video
Source

Video
Source

Video
Dimension
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Hide History
The Hide History button allows you to display or hide the VideoSecurity
panel containing the recorded information everytime an motion is detected
in the scan area.

Click on the list box to select folder.

Click Explore to search other
recorded files in your hard disk.

Click Delete All if you want to
delete all recorded conditions in the
current folder.

Click the picture to view the
recorded image or video.

Click Delete if you wish to delete
this recorded condition.

If the recorded condition is a video,
the View Video button is added.
Click button to watch video.

Detect region
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2.4 ASUS VideoSecurity Setup
Click the Setup button from the ASUS VideoSecurity main menu to display
the Setup dialog box.

Main

The Main tab contains the sensibility, frame per second interval, detect
region, windows style, autorun, warning sound and timer settings
necessary for the optimal performance of the VideoSecurity utility.

Detecting Sensibility
Detecting sensibility  sets the receptibility of VideoSecurity to environment
changes. Temperature and lighting are important factors that may affect
monitoring. The quality of the video capture device is also very important
in setting the sensibility. For optimum performance, test the performance
several times using different values to fine-tune this parameter. The
Default button sets this parameter to its optimum setting based on normal
light and temperature conditions.

Detecting Interval
The interval (frame/sec) or scan rate has four default values. Configuration
options include: 1 frame/sec, 2 frames/sec, 3 frames/sec and 4 frames/
sec. Set to a higher scan rate for a more accurate detection. The Default
button sets this parameter to its recommended setting.
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Do not change the working folder’s name while VideoSecurity is
running. Doing so will cause a fatal runtime error.

Detect Region
• The Full Window setting will detect all area visible from the video

capture device when the VideoSecurity watchdog is on.

• The User defined region detects only the area defined by the user
when the VideoSecurity watchdog in on.

Window Style
• The Normal setting is the default option. If you select this option the

VideoSecurity dialog box will display as a general Windows program.

• The Minimized as a tray icon setting will put the VideoSecurity icon
on the taskbar in the lower-right corner of your screen. Whenever
VideoSecurity detects a problem it will execute automatically or you
can also run VideoSecurity by double-clicking on the icon.

• The Always on top setting initializes the VideoSecurity dialog box as a
normal window and always appear on top of other windows, dialog
boxes or applications.

Check boxes
• The Auto-run whenever system boots up check box enables or

disables the autorun feature of VideoSecurity. When checked or
enabled, the VideoSecurity utility executes automatically when the
system boots up.

• The Play warning sound check box enables or disables the warning
sound whenever VideoSecurity detects a problem.

Working Directory
The working directory sets the storage folder or directory for all the image
and video files. The default directory is C:\VideoSec, or select another
folder by clicking the command button with a directory tree icon. Everytime
you execute VideoSecurity, a new folder is created in this working
directory. The created folder filename denotes the current time and date
VideoSecurity application was launched. For example,
“2003.08.26_04.10.10”, meaning VideoSecurity was launched on August
26, 2003 at 4:10:10 PM.
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• The Start detecting after: XXX seconds check box enables or
disables the scheduled execution option and allows you to set the
number of seconds VideoSecurity will automatically start detecting.
Click the up or down arrow to input the number of seconds
VideoSecurity will start detecting.

Working Mode

The Working Mode tab enables you to set the VideoSecurity actions
when any unusual condition is detected.

• The Start tracing and users can choose to stop option button sets
VideoSecurity to start a trace when a motion is detected until the
motion object is out of the scan area. The system prompts a tracing
box to specify the handling procedure.

• The Start tracing and automatically stop tracing when the target
stays still for XXX seconds option button allows you to set the
handling procedure when a motion is detected until the motion object is
out of the scan area. You can also set the time (in seconds) when
VideoSecurity stops tracing once the motion object stops moving.
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• The No tracing option button sets VideoSecurity to perform no action
even when a motion is detected on the scan area.

• The Stop detecting immediately option button sets VideoSecurity to
immediately stop the watchdog function when a motion is detected on
the scan area.

• The Continue detecting, unless users press [Stop]  option button
sets VideoSecurity watchdog function to stop only when the user press
the [Stop] button.

• The When conditions continue to happen for over XXX times, stop
detecting option button stops the VideoSecurity watchdog function
when the motion detected repeats the number of times as specified by
the user.

Procedures

The Handling Procedures tab enables you to set the VideoSecurity
parameters for Recording, Send Email, Make phone call and Execute
specific program handling procedures.

Recording Video
Check the Start recording whenever there’s an unusual condition
occurs check box to enable this feature. Input the duration of recording (in
seconds) or click on the up/down arrows to increase or decrease field
value.
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Sending email
The Send out an email as warning check box allows you to enable or
disable this feature. When the check box is enabled, it requires you to
input the email addresses of note recipient, edit the body of the email and
set the Simple Mail Transfer Protocol (SMTP) parameters.

• Email Address - the electronic mail address of the main recipient of
the note when the VideoSecurity watchdog detects a motion in the
scan area.

• CC - the recipient of a copy of the note sent to the main addressee.

• Body - enables you to encode the content of the note to the main
addressee. Press the Edit button
to encode your notes.

Click OK after encoding note or
Cancel to abort.

• SMTP Mail Server Setup - contains the parameters and protocols
necessary in sending your email.

Input the Outgoing Mail Server-SMTP server IP address, for example
168.187.2.22 or the domain name like, mail.company.com.

The My server requires authentication check box allows you to input
your User ID and password. The Remember my  password check
box saves an encrypted copy of your user ID and password and
appears as default everytime you execute this setup.

Click OK after the configuration or Cancel to abort.
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Dialing
Enable the Making phone calls by modem  check box to use this
handling procedure. When enabled, the following fields are activated:
country code, area code, telephone number, redial attempts, the modem
setup button, voice message recording options and its .wav file folder
location.

•    Area code - the digital area code of the location of the recipient.

• Country code - the digital country country code of the recipient.

• Number - the digital telephone number of the recipient.

• Redial Attempts - specifies the number of redials you want in case the
connecting line is busy.

• Model setup - this button launches the ASUS Phone Dialer that allows
you to configure your modem connection.

• Record Now - this button launches the Windows sound recorder to
enable you to record, edit, mix and save sound files using wave (.wav)
format. The wave file created is sent to the recipient when a warning
phone call is made. When recording wave files, make sure that the file
format has 8kHz of sample rate, 16bit sample size and 1 channel. The
default .wav file name is “warning.wav”.

• Voice message - this field is for the location of the wave file you want
to send when a warning phone call is made. Make sure that the wave
file exists in the folder.

Executing Programs
The Execute specific program handling procedure option enables you to
specify the program filename and path to run when the VideoSecurity
watchdog detects a motion in the scan area.
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Device

The Device tab enables you to set the video and color tuning
configurations.

Video Capture Devices
The Video Capture Devices box allows you to choose from the available
capture devices and set a compatible video standard. Click the combo list
box to display the options for each parameter.

Color Settings
The Color Settings box contains tools for color correction requirements.
Adjust the Brightness, Saturation, Contrast and Hue by moving the slider
sideways. Click the Default button to load the recommended default
values for each parameter.
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Click OK after the configuration or Cancel to abort.

Click the Apply button to load the default values for the handling
procedure settings.

Click the Help button to launch the ASUS VideoSecurity on-line help.

Advanced

The Advanced tab allows you to enabled or disable the HTTP server and
configure its parameters.

Enable HTTP Server
The Enable HTTP Server check box allows you to enable or disable the
HTTP Server. When enabled, the succeeding parameters are activated.
Input your Internet Protocol (IP) address, Port and connection timeout in
seconds.

Enable server authentication
The Enabled server authentication check box enables or disables the
server authentication feature. When enabled, it requires you to input the
account name and password.
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3. ASUS GameFace
ASUS GameFace is a real-time audio/video communication feature that
enables point-to-point video conferencing functions and online gaming to
take place at the same time. Follow the given steps in using ASUS
GameFace.

You can also enable the On-
Screen Display (OSD) in the
GameFace application.

STEP 1: Enable ASUS OSD

STEP 2: Launch ASUS GameFace

• Open Display Properties
dialog box from desktop or
control panel.

• Select Advanced tab on
Settings page.

• Select OSD from in Advanced
tab.

• Check the Enable OSD check
box and input the appropriate
hotkey.

• ASUS GameFace automatically
detects the connected audio/
video WDM capture device
upon start-up. You can change
the input device from Options
in the Tool menu if you have
more than one audio/video
device.
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STEP 3: Local Playback Mode

STEP 4: Network Playback Mode

• Select Local Play/Stop from
the File menu to start local
playback when local video is not
playing.

• Select Local Play/Stop from
the File menu to stop local
playback when playing local
video.

• You can also press the
Play/Stop button to start or stop
local playback.

• Connect to remote computer:

- Input the computer name
(Local Area Network) or IP
Address in the combo box.

- Select New Call from the
File menu or press the
“Make a Call” button.

- You will see and hear the
remote audio/video signal if
the remote computer
accepts the call.

For computer name and IP
addresses go to Tools->Info
for lists of information.



ASUS Graphics Card Software Reference16

STEP 5: GameFace Settings

• Waiting for connection:

- Launch ASUS GameFace

- A message box appears on
an incoming call. Click Yes
to accept the call.

- Select End Call from the
File menu or press the
“End the Call” button to
disconnect.

• Select Option from the Tool menu.

• Select GameFace Option Dialogue

• Enter GameFace page to adjust transparency, position and hotkey
settings.
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STEP 6: Launch Game and show GameFace

• Begin your game.

• After entering Full-Screen mode, press the hotkey
(default is Ctrl+Alt+V) to activate GameFace.

• Press the On-Screen Display hotkey to show the OSD menu.

• Use the arrow keys to select the GameFace application page and
adjust the Transparency, Position X, Position Y, Size or toggle to
enable or disable GameFace.



ASUS Graphics Card Software Reference18

4. ASUS Digital VCR
With ASUS Digital VCR, you can watch and record TV programs from your
TV tuner, and also can enjoy all kinds of media effortlessly from numerous
signal inputs, such as analog, digital camcorders, VCRs, and PC cameras.
The “Channel Surfing” function allows you to watch  a snapshot of 16
channels at one time while refreshing itself continually. Two different kinds
of skins are available for users to choose.

Click here to switch skin

1. The following can only be used as a general reference and may
not be an exact reflection of the software version you are using.
The contents are subject to change at any time without notice.

2. For MPEG-1 recording, the minimum system requirement is
Pentium II 350 or AMD K6 family at 450 MHz. For MPEG-2
recording, the minimum system requirement is Pentium III 650
MHz or Athlon 650 Mhz.

3. Make sure that the latest DirectX driver version is installed on your
system.
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Running ASUS Digital VCR

To run the utility, click Start and point to Programs and then ASUS Digital
VCR  and then click ASUS Digital VCR.

You may also run ASUS Digital VCR by clicking or right-clicking the ASUS
Control Panel icon (see 4. Software Reference | ASUS Control Panel)
on the taskbar’s status area to display the ASUS Control Panel, pointing to
ASUS Digital VCR, and then clicking it.

Uninstalling ASUS Digital VCR

To uninstall the software, click Start and point to Programs and then
ASUS Digital VCR and then click Uninstall. You may also uninstall the
software using the Add/Remove Programs Properties dialog box at the
Windows Setup tab. Windows online help for more information on
removing a Windows component.

Using ASUS Digital VCR

ASUS Digital VCR has been designed as a standard Windows program.
The functions can be accessed by means of ASUS DVCR panel or by
right-clicking the VCR screen.
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Easy Access

The user-friendly skin allows you to easily operate the ASUS Digital VCR.
Just like your TVsets and VCRs, you can quickly access to most of the
functions with one single click.

Enable full screen

To enable full screen, click the Full Screen button or use the hot key,
CTRL+S. To disable full screen, double-click the display, then click the Full
Screen button.You may also use CTRL+S or ESC to disable full screen
display. The display will then revert to its previous size.

Enable wallpaper display

To Enable wallpaper display, click the Wallpaper button or use CTRL+W.

To disable desktop wallpaper, double-click anywhere the display and then
click the wallpaper button. You may also use CTRL+W to disable the
desktop wallpaper.

Before using the Enable wallpaper display option, make sure that the
View as Web Page option of the Active Desktop setting is not selected
(see Start – Settings –Active Desktop – View as Web Page).
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Always on Top

The Always on Top option is provided for users who may wish to continue
watching VCD/DVD/TV programs or want to have the ASUS Digital VCR
monitor visible while doing other tasks, such as when downloading files
from the Internet or word processing. To keep the monitor always on top of
other programs, click the Always on Top button or select the Always on
Top  command from the Window(W) menu. Position the monitor where it
will not interfere with your other tasks.

To disable the Always on Top option, click  or select the Always on Top
command from the Window(W) menu.

Setup

When first using ASUS Digital VCR, you must set up the video source.
Use the Setup button on the ASUS Digital VCR Control Panel or use the
F9 hot key to show or hide the video source setup screen on the monitor.

Use your mouse/pointing device or the UP and DOWN arrow keys to
select options (Brightness, Saturation, Contrast, Hue), and the LEFT
(select to the left or to decrease) or RIGHT (select to the right or to
increase) arrow keys to change an option. You may also use your mouse/
pointing device to change an option by clicking the appropriate item or
slider.

Video Source

Select the Video Standard from the list.

If the Video Standard is not set up on
the Video Source page, it will be
decided when you choose your country
on the TV Tuner page.
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Capture

Click the Capture tab to select video capture settings. There are four
default profiles in Record Profiles drop-down list. Click the arrow to
create your most-frequently used settings.

IMPORTANT: It is the intent of ASUS that this product be used in full
compliance with the copyright laws of your respective and other
countries and that prior permission be obtained from copyright owners
whenever necessary.
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Click Video source button to select the video source. Capture the images
you want by clicking the snapshot button then use consecutively
numbered filenames to store the images.

The innovative TimeShifting™
feature of the ASUS Digital VCR lets
you record incoming video feeds into
a buffer. So if you are watching your
favorite TV show on your computer
and you had to leave but you don’t
want to miss the rest of the show, all
you need is to record it with ASUS
TimeShifting™. When you come
back, you don’t have to wait (unlike
traditional recorders) for the
recording to finish to be able to
watch what’s been recorded. Just click Play and playback will start
immediately (this while recording still continuing in the background)!

The de-interlace mode is used to filter the artifact from the interlaced TV
signal. But it drains more system resources. Hence recording performance
might decrease.It depends on your system capability to decide whether to
use the deinterlace mode or not.

Timeshift
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The ASUS Digital VCR provides Frequency Tuning function and helps you
get the right signal. Click the Frequency Tuning button to fine-tune the
channels and to modify the TV signal if the built-in tables don’t work.

After completing the settings, you can execute Channel Surfing by clicking
the Channel Surfing button to simultaneously view a snapshot of 16
channels, rather than a flipping through all the channels.

TV Tuner

Click the TV Tuner tab to select your TV receiver and country.
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Devices

Click the Devices tab to set up your Video Device and Audio Device. Many
capture devices are supported by digital VCR. After a correct installation of
the WDM device driver, Digital VCR will list all the available devices.
Select  the mixer line you use to input the live audio so that Digital VCR
can properly record it into files.
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5. ASUS SmartDoctor
ASUS SmartDoctor is designed to satisfy two major goals. One is to
monitor the graphic chip status, alerting users about abnormal events,
such as fan malfunction or chip overheat. The other, as the name
“SmartDoctor” implies, is to “cool” down the graphic chip smartly when it is
not necessary for it to be kept running at full speed.

5.1 Functions

• Monitors graphic chip temperature, fan speed and voltage

• Notifies users about irregular hardware events, such as temperature
overheat, fan malfunction, and out-of-safe-range voltage.

• Forcibly cools down the graphic chip when the graphic chip’s
temperature is over an acceptable temperature, to protect the graphic
chip from overheat damage.

• Cools down the graphic chip’s temperature when it is idle, and restores
it to its maximum capability once needed, thus smartly extending the
graphic chip’s lifetime.

• Cools down the GPU’s temperature to lengthen GPU lifetime.

• Sets monitor’s tolerable range or value to fit system’s requirement.

• Speed up system by adjusting core and memory clock slider manually.

• Provide 5 levels of fan speed adjustment.

AGP bus VDDQ Voltage and AGP bus 3.3 Voltage should be supplied
steadily by your motherboard. Otherwise, your system will crash.
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The default setting of SmartDoctor is keep resident which means that
SmartDoctor will run every time Windows start and check the graphic
card’s status.

If your graphics card is working properly, SmartDoctor will terminate within
5 seconds.

Dynamic Settings will become available when you uncheck Run once
and terminate.

• Monitoring polling time interval lets you specify the time intervals
that SmartDoctor will take to check the graphic chip. The default setting
is 5 seconds. You can choose a longer time interval value.
SmartDoctor, however, will be less sensitive to graphic chip condition
changes.

• Enable GPU cooling allows you to enable or disable the GPU cooling
option. Enabling GPU cooling option will cool down the GPU’s
temperature when SmartDoctor detects that the GPU is idle. The GPU
temperature will then drop.

5.2   Setup
When you click the Setup button, the Smart Doctor2 Settings dialog box
appears.

 If you have already installed any GPU cooling software in your
system, you should just choose only one. Running more than one GPU
cooling software at the same time is redundant.

After GPU cooling is enabled, and when you run System Monitor in
Programs–Accessories–System Tools to monitor GPU usage, you will
find that GPU usage has reached its maximum, that is, 100%. Do not
be alarmed—this is normal.
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• Enable dynamic graphic cooling allows you to enable or disable the
dynamic graphic cooling option. Enabling the graphic cooling option
will cool down the graphic chip’s temperature when SmartDoctor
detects that the graphic chip is idle.

• Enable overheat protection lets you forcibly cool down the graphic
chip when temperature is over the tolerable range or value.

Click the Monitor tab to specify the
alarm settings for voltage,
temperature, and fan, that fit your
system.

Click the Fan Control tab to set
smart cooling settings. When the
Dynamic Fan Control is enabled,
you may individually adjust dynamic
fan speed levels or set to default
values and Smart Cooling will
automatically adjust fan speed to
prevent overheating. Also, you may
set the fan speed fixed at a desired
level.

When SmartDoctor senses that something is wrong with your card
graphic chip, the message display region will show a detailed descrip-
tion of the error or problem. The component in question will also have a
flashing red value. If you enabled overheat protection in Smart
Doctor2 Settings dialog box, SmartDoctor will cool down the graphic
chip in time to protect it from possible overheat damage.
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5.3   Set/Test
When you click the Set/Test button, the Smart Doctor2 tests the graphic
card onscreen memory and displays the following screen while
testing.
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